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1 The list of terms used

The Guide - this document.

The system - the Auto-Intellect software system.

Server - computer with installed Auto-Intellect software package.

Traffic - the flow of vehicles.

Vehicle Tracer - the interface object designed for viewing the recognized LP numbers, the types and speeds of vehicles, as
well as for searching the LPR database and creating reports for specific time periods.

Traffic Monitor - the interface object designed for monitoring vehicle movement.

7. fps - frame frequency. Number of video stream frames processed by software per 1 second.

o

o
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2 Operator's Guide. Introduction
On page:

+ The purpose and structure of the Guide
« The purpose of the Auto-Intellect system
« Recommendations for using the Auto-Intellect system

2.1 The purpose and structure of the Guide

The Guide is an informational reference designed for users of the Auto-Intellect system with Operator access rights responded for
operation with Auto-Intellect software and corresponding interface objects.

The Guide contains the following material:

1. General description of the Auto-Intellect software system.
2. How to use the Auto-Intellect software system.
3. Description of the user interface of the Auto-Intellect system.

2.2 The purpose of the Auto-Intellect system
The Auto-Intellect software system is designed for automated traffic monitoring and control, and has the following functionality:

1. License plate number recognition.
2. Centralized events registration and processing, generation of notifications and control commands according to flexible

algorithms.
Searching matches between the recognized plate number and the numbers in the database connected to Auto-Intellect.

Creating the photo and video archive.
Determining the overall traffic parameters and the parameters of individual vehicles.
Software scalability.

o0 sw

2.3 Recommendations for using the Auto-Intellect system
The Auto-Intellect software is installed as an extension to the Intellect software package.
For proper operation of the Auto-Intellect system, please follow these recommendations:

1. Follow the job description accurately.
2. Use the system for the intended purpose only.
3. Do not use the computer with Intellect installed, to run other software which is not part of the Intellect package.

Operator's Guide. Introduction - 5
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3 Using the Auto-Intellect software system

3.1 Starting and closing the system

Please check the working condition of all hardware components - connections, cameras, etc - prior to starting the system.

o Intellect

Shutdamn

The system can be started using one of the following methods:

1. Automatically. The system starts automatically after the operating system boots up.
2. Manually. To start the system manually, in the Start menu, select Programs -> Intellect -> Client Workstation, or use the
corresponding shortcut on the Desktop.

Access to the system can be protected by a password. In this case, enter your password to start the system.
To shut down the system, do the following:

1. Point the mouse to the upper right corner of the screen, the main control panel will open.

2. Clickthe E icon on the panel.
3. Select Shutdown in the menu that opens.

The shut down process will start, the password will be required if set.

Using the Auto-Intellect software system - 6
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(2 Intellect

() Note.

The system can be set up to forbid the shut down. Then, the Shutdown item is not present in the menu.

3.2 Using the Traffic Monitor interface object

3.2.1 Displaying the current traffic information in table form
The table with current traffic parameters is shown in the Table sub-tab of the Current value tab.

Displaying the current traffic parameters by lane in a table.

Using the Auto-Intellect software system - 7
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Displaying the current traffic parameters by direction in a table.

Using the Auto-Intellect software system - 8



Operator's Guide

The system can be set up to display the traffic parameters by lane or by traffic movement direction. In case of the by-lane display,
the columns correspond to traffic lanes, and rows correspond to traffic parameters. In case of the by-direction display, the
columns correspond to traffic directions, and rows correspond to traffic parameters.

(@ Note.

The Time of registration parameter for each lane corresponds to the time when the last vehicle passed. The Time of
registration minus the Statistics update period is taken as the beginning of the period to base the statistics on, while
the current moment is taken for the end of the statistics period.

3.2.2 Displaying the current traffic information in graphic form
The charts with current traffic parameters are displayed in the Charts sub-tab of the Current value tab.

Displaying the charts of current traffic parameters by lane.

Using the Auto-Intellect software system - 9
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Displaying the charts of current traffic parameters by direction.

Using the Auto-Intellect software system - 10



Operator's Guide

Current Value ' Statistics Lraffic monitor 1
|/ Table % Charts
| Traffic Detector 2 =l
Total vehicles registered: | 10100 i Free
O
THT Legend
a1
—r— Average sp
eed for al
g = B | vehicles
g g [k}
E % 54 =—tr— Average sp =
E e % A, eed for pa
5 i g SSenger ca
g Vehicle's amount é rs (kmih)
27 Awverage sp
15 eed for tr
-
J L) L) L} ¥ LJ LJ LJ T
11:54:54
04.02.2009

-

The system can be set up to display the traffic parameters by lane or by traffic movement direction.

The Charts tab consists of several sections corresponding to the lanes or the traffic movement directions. Each section consists
of several subsections displaying some particular sets of traffic parameters in graphic form.

3.2.3 Creating a request for traffic statistics

To create a request for traffic statistics, use the Statistics tab.

Save Az
Statisticz per day || Statistics per week | Statistics per month | Selective statistics 2
etechiong Total n... | Averag... | Violatio... Speedi...lMDving...| Total v...|.-’-‘-.verag...|Traffiu: s,
= Traffic Detection 1 0 ] z 0 =z 0 0 =0 1] =z 0
Bl Movement towards camera = 0 ] = 0 = 0 = 0 =10 1] = 0
= Lane 1 z 0 1] =0 =0 Z 0 =0 1] =0
- Paszenger cars ] ] 1] 1] ] ] 1] 1]
- Trucks lesz than 11 m long ] ] 1] 1] ] ] 1] 1]
Trucks from 11 to 14 mlong 0 1] 1] 1] 1] 1] 1] 1]
- Trucks morethan 14 mlong 0O ] 1] 1] ] ] 1] 1]
----- Buzes ] ] 1] 1] ] ] 1] 1]
E- Lane 2 0 0 z 0 =z 0 0 =10 1] Z 0
- Lane 3 0 ] =0 0 0 =0 1] 0
- Lane 4 Z 0 1] =0 =0 0 =0 1] =0
Eﬂ able™¥, Charts /
FReady

To create a request for traffic statistics, do the following:

Using the Auto-Intellect software system - 11
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1. Select the preferred type of statistics presentation by clicking the Table or the Charts tab.

Select the sampling period - Day, Week, Month, or Specific time period (specify the period manually).

3. If Specific time period is chosen, enter the beginning and the end date/time of the statistics period in the Beginning and
the End fields.

4. Click the Refresh button to create or update the statistics.

N

3.2.4 Displaying traffic statistics in table form

The traffic statistics in table form are displayed in the Table sub-tab of the Statistics tab.

/ Currert value‘@t_atistiﬁh
; Beginni..|| BE End| B C_Flefresh_) | Saveps.
| Statistics per week | Statistics per month | Selective statistics
etections | Total n... |.-'1‘-.verag... |"-.r"i|:||ati|:|...| Speedi.. | Ml:uving...| Total +... |.-“-‘-.verag... | Traffic |
= Traffic Detection 1 =0 1] =0 =0 =0 =0 0 =0
B Mavement towards camera =0 1] =0 =0 =0 =0 1] =0
B Lane 1 =0 1] =0 =0 =0 =0 0 =0
- FPazzenger cars ] ] 1] ] ] ] 1] 1]
- Trucks lezz than 11 m long ] ] 1] 1] ] ] 1] ]
- Trucks from 11 to 14 mlong 0 ] 1] 1] ] ] 1] 1]
Trucks more than 14 mlong 0 1] 1] 1] 1] 1] 1] 1]
- Buses N N 0 0 N N 0 0
- Lane 2 =0 1] =0 =0 =0 =D 0 =0
E- Lane 3 =0 1] =0 =0 =0 =D 0 =z 0
- Lane 4 =0 1] =0 =0 =0 =0 0 =0
\. J/
Table & Charts /
FReady

The traffic statistics are displayed in the following tree structure: Recognizer name -> Movement direction -> Lane -> Vehicle
type. The statistics data for each level of the tree is shown.

() Note.
To refresh the displayed statistics, click the Refresh button.

3.2.5 Displaying traffic statistics in graphic form

The traffic statistics in graphic form are displayed in the Charts sub-tab of the Statistics tab.

Using the Auto-Intellect software system - 12
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Current Value |/ Statistics ) Iraffic monitor 1
Beginni...| 2 5 0:00:00 Refresh | Save as... I
’ Statistics for a day ||| Statistics for a week | Statistics for a month | Selective statistics I
Traffic Detector 2 I ‘ Jed
Incidents detected
19 | L1 |
T — o =
4
Moving along the oncomi... | 0 A \
Number of vehicle stops | ] g 152 /
Jam | 1] E § 133 J(/
Legend
10 = e o5 \} g
E = E L Traffic speed
= B : 'E & —— Traffic dens
= = Ly ity
o g =
g A
o
il
1
0 0
09:00:00 10:12:04 11:24:08
04-02-2009  04-02-2009  04-02-2009
Time Time
Incidents detected T
¥
Speeding 0 e f—1"TY
= x per o
Moving along the oncomi... | 0 ! / \
Number of vehicle stops [1] g 24 //
Jam 1] o 2 2 (/ 5
= @
g &
= < - \ Legend
m 15
(‘: 27 = = Traffic speed
= 24 @
o g 21 -E _i i =ir— Traffic dens
- 1 = :
g 1s = %
= 1
=
=
2
2
0 G
09:00:00 11:06:07 09:00:00 10:12:04 11:24:08
04-02-2009 04-02-2009 04-02-2009  04-02-2009  04-02-2009
Time Time
Incidents detected | X
1| 3
Table 4 Charts
Ready o]
(@ Note.

To refresh the displayed statistics, click the Refresh button.

3.2.6 Saving traffic statistics to a file

The Statistics tab allows saving the traffic statistics into a file.
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¢ Current value ¢ gtatistiﬁb
Beginri..| BEl | B Refesh | Savess. )

Statiztice per day ||| Statistics per week | Statistics per month | Selective statistics

Detections | Total n... |.-'-‘-.~.ferag... |"»-’i|:|lati|:|...| Speedi.. | I'-.-1|:|\-'ing...| Total ... |.-’-'-.verag... | Traffic: ||
= Traffic Detection 1 =0 1] =0 =0 =0 =D 0 =0
B Movemertt towards camera =0 1] =0 =0 =0 =0 0 =0
B Lane 1 E0 1] =z 0 =0 E0 =0 0 =0
- Fazzenger carz ] ] 1] 1] ] ] 1] 1]
Trucks lesz than 11 m long 1] 1] 1] 1] 1] 1] 1] 1]
- Trucks from 11 to 14 mlong 0O ] 1] 1] ] ] 1] ]
- Trucks morethan 14 mlong 0O ] 1] 1] ] ] 1] 1]
- Buses 0 0 0 0 0 0 0 0
E- Lane 2 =0 1] =0 =0 =0 =0 0 =0
E- Lane 3 E0 1] =z 0 =0 E0 =0 0 =0
B Lane 4 =0 1] =0 =0 =0 =D 0 =0

Table 4 Charts /

Ready

To export the traffic statistics into a file, do the following:

1. Create and display the request for traffic statistics (see the Creating a request for traffic statistics section).
2. Click the Save as button.

3. Enter the pathname in the window that opens and click Save.

4. The traffic statistics will be saved in the specified location in a CSV file.

3.3 Using the Vehicle Tracer interface object

3.3.1 Introduction

The Vehicle Tracer interface object includes the following components:

1. On-line monitor - is designed for displaying the data about identified plates and for handling alarms;

2. Events monitor -displays video frame with a vehicle, which plate is being recognized at the moment and also identified
number and speed.

3. Alarm window - is designed for displaying the data about vehicles in case of coincidence of recognized plates with plates
which are stored on the external orientation database.

() Note.

Events monitor and Alarm window components are optional and aren't displayed with corresponding system settings
(see the document Auto-Intellect software package: Administrator guide).

3.3.2 Viewing the data about passing vehicle

The passing vehicle data is displayed in the Events monitor window.

Using the Auto-Intellect software system - 14
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LPR channel 1

M843BA163 3

(@ Note

Events monitor component may not be displayed due to the corresponding system settings.

In the Events monitor window, the following data is displayed:

1. LPrecognizer (the name of the corresponding LPR channel object) (1);

2. vehicle video frame with a caption, which can contain the following data (2):

date and time of receiving data about the vehicle;

vehicle speed;

vehicle direction;

speed detector ID number;

name of the video camera that detected the vehicle;

and other information about the speed detector (see Setting up the frame sign parameters).
3. |dent|f|ed LP number and the LP image (3).

(@ Note

+ Ifthe LP number hasn't been recognized, UNDEFINED message will be displayed in the field.

« If the characters of the recognized number are displayed incorrectly, it is necessary to change the font of
the recognized number to the one that will contain all the characters of the corresponding country LP
numbers (see Setting up the font of the recognized LP number).

+ The image of the recognized license plate is compressed or stretched to fit the red frame.

BRI

(@ Note

+ In case the AUTO-Uragan or CARMEN-Auto module is used for identification, allowed speed, vehicle speed and
speed detector ID number are displayed only if the Speed traps server module is connected.

+ In case the alarm is registered for a vehicle (overspeeding, and/or identification of a plate in the external plates
database), the field with a video frame is highlighted with red (2).

Using the Auto-Intellect software system - 15
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3.3.3 Viewing the data about the last identified vehicle

The last identified vehicle data is displayed in the Last event group of the Online monitor window (left area of this window).

ONLINE MONITOR Server status

a
Alarm

[ E034CP63 l

LPR channel 1
2020-07-13 11:48:53

[ E322YC163

LPR channel 1

. ; 2020-07-13 11:45:43
M763K0163 :

[ E183MC163

- - - LPR channel 1
Recognizer LPR. channel 1 = 2020-07-13 11:48:38

Parameter Value

Country |Russia

Recognition time |2l] 20-07-13 11:48:29 n
Speed 27 kmy/h e [ Y500YH63
Speed limit |40 km/h | — ] LPR channel 1

validity 0 % I 2020-07-13 11:48:34

Direction [To camera
Regional code |163

Camera |camera 1

K673YK163

(@ Note

If there is an event selected in the identified vehicles protocol or in the alarms protocol, the data about this event will be
displayed in the Last event group (see Viewing the protocol of the identified vehicles, Viewing the alarms protocol).

Viewing the data about the last identified vehicle is performed in the following way:

Using the Auto-Intellect software system - 16
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1. The vehicle video frame with a caption is displayed in the filed (1).

ONLINE MONITOR

M763K0163

Parameter | Value

Recognizer |LPR channel 1

Country |Ru ssia

Recognition time |2020-07-13 11:48:29
Speed |3 7 km/h

Speed limit l40 km/h

validity 8o %

Direction Ito camera

Regional code |163

Camera |Ca mera 1

2. Theidentified LP number and the LP image is displayed in the field (2).

() Note

+ If the LP number hasn't been recognized, UNDEFINED message will be displayed in the field.

« If the characters of the recognized number are displayed incorrectly, it is necessary to change the font of
the recognized number to the one that will contain all the characters of the corresponding country LP
numbers (see Setting up the font of the recognized LP number).

+ The image of the recognized license plate is compressed or stretched to fit the red frame.

3. Depending on the available data, the following information can be displayed in the box (3):
a. Inthe Recognizer field, the name of the LP recognizer is displayed (the name of the corresponding LPR
channel object).
b. Inthe Country field, the country to which belongs the identified LP number is displayed.

Using the Auto-Intellect software system - 17
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(@ Note

This field is not displayed when the LPR IntelliVision module is used for recognition.

In the Recognition time field, the date and time of receiving the vehicle information is displayed.
In the Speed field, the vehicle speed is displayed.

(@ Note

In case the AUTO-Uragan or CARMEN-Auto modules are used for identification, and the Speed traps
server module is not connected, zero speed value is displayed.

() Note
Depending on the Vehicle Tracer settings, the speed is displayed in km/h or mi/h.

In the Speed limit field, the speed limit allowed on this part of the road is displayed.
In the Speeding field, the difference between the captured vehicle speed and the speed limit allowed on this part
of the road is displayed.
() Note
This field is displayed if the speeding event was registered, otherwise this field is absent.
In the Validity field, the identification validity rate is displayed in percent.
In the Direction field, the vehicle's direction is displayed (Undefined, To the camera, From the camera, To the
right, To the left).
In the Regional code field, the regional code of the recognized LP is displayed.
() Note
This field can be hidden (see Setting up the Vehicle Tracer interface window).
In the Camera field, the name of the video camera which captured the vehicle is displayed.
In the SDK data file field, the data file about the triggered engine is displayed.
() Note
The SDK data file field is displayed only if the ARH-Railway module is used.
In the Address field, the camera location address is displayed.
In the Identificator (Ne) field, the camera ID number is displayed.
In the Certificate (Ne) field, the certificate number is displayed.
In the Calibration field, the calibration expiration date is displayed.
In the Vendor and Model field, the vendor and model of the recognized vehicle are displayed.
() Note

The Vendor and Model fields are displayed only if the RoadAR vendor and model recognizer is used.
In the Type field, the type of the recognized vehicle is displayed.

() Note

This field is displayed only if the Vehicle type recognition module and/or the RoadAR vendor and
model recognizer are used.

In the Dangerous goods class and Dangerous goods composition fields, the class and the contents of the
dangerous cargo are displayed correspondingly.

Using the Auto-Intellect software system - 18
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(@ Note

The Dangerous goods class and Dangerous goods composition fields are displayed only if the CARMEN-
Auto module and the Hazard Identification Number Recognition Engine (ADR) are used.
s. Inthe GPS coordinates field, the coordinates of the camera installation are displayed.

Viewing the data about the last identified vehicle is complete.

() Note

In case an alarm was registered for a vehicle, the reason of alarm is also displayed in the Last event group.

(@ Note

The data about any event selected in the identified vehicles protocol or in the alarm protocol can be viewed in the same
way (see Viewing the identified vehicles protocol, Viewing the alarms protocol).
A passing vehicle event can be created using a script (see Scripts used in the Auto-Intellect software package).

3.3.4 Viewing the identified vehicles protocol
The identified vehicles protocol is displayed in the Online monitor window.

To access to the protocol, go to the Events tab (1). The identified vehicles protocol is a table which contains the information
about identified vehicles (2).

OMNLINE MONITOR Server status

K673YK163

LPR channel 15
2020-07-13 11:55:306

l M763K0163

LPR channel 1

y 2020-07-13 11:55:28
Ko673¥K163 ==x —

l E339H0O163

Parameter Value

" | % LPR channel 1
Recognizer LPR channel 1 | 5, 2020-07-13 11:55:10

Country |Russia
Recognition time |2l]2l]—[)?—13 11:55:30

Validity |83 % l M843BA103
Direction [To camera

LPR channel 1
Regional code 163 2020-07-13 11:55:05

Camera |Ca mera 1

BM59863

o] |

Video archive Filter

For every vehicle (event) the following data is displayed:

1. video frame of the vehicle (3);
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2. identified vehicle LP number (4);

() Note

+ If the LP number hasn't been recognized, UNDEFINED message will be displayed in the field.

« If the characters of the recognized number are displayed incorrectly, it is necessary to change the font of
the recognized number to the one that will contain all the characters of the corresponding country LP
numbers (see Setting up the font of the recognized LP number).

3. vehicle speed;

() Note

Vehicle speed is displayed only if the Speed traps server module is connected.

4. LPRchannel (5);
5. date and time of receiving the information about the vehicle (6).

For alarms, the information about reasons of alarms is also displayed (see Alarms operation). The alarms which were not
processed by the operator, are highlighted with red, and processed alarms are highlighted with yellow (see Alarm processing).

(@ Note

Any alarm event is duplicated: first, an event message with a recognized LP number is received without an alarm, then
the same message is received with alarm. You can hide the processed events (see Hiding the processed events in the
protocol).

To view the detailed information about the event, do the following:

1. Left-click the required event.

2. Asaresult, the data about the vehicle will be displayed in the Last event group. Online update of the identified vehicles
protocol will be suspended.

3. View the data about the event as described in the Viewing the data about the last identified vehicle section.

4. Torestore the online update of the identified vehicles protocol click the Trace button in the upper area of the Online
monitor window.

Server status

az
E322VC163

A232CX1063

LPE. channel 1
2020-07-13 11:58:59

M942BY163 |

LPR. channel 1
2020-07-13 11:58:57

Viewing the detailed data about the event is complete.
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3.3.5 Alarms operation
Alarms operation is done in the On-line monitor window.

Alarm is triggered by one of the following ways:

1. automatically - in case of overspeeding or vehicle's plate identification in the external database;
2. manually.

3.3.5.1 Manualalarm triggering
To enable the manual alarm triggering, do the following:

1. Left-click the required event in the identified vehicles protocol (1).
ONLINE MONITOR Server status

K673YK163

LPR channel 1
2020-07-13 12:02:29

M763K0163

LPR channel 1
2020-07-13 12:02:28

[Par 10 Value
Recognizer LPR channel 1 : : A 2020-07-13 12:02:09

l E339HO163

¢ LPR channel 1

Country |Russia

Recognition time |2l]2l}—l}}‘—13 12:02:28
Speed |37 km/h [ M843BA163
Speed limit |40 km/h LPR channel 1

Validity |so 2 2020-07-13 12:02:04

Direction [To camera
Regional code |163
Camera |camera 1

BM59863

2. Click the Alarm button (2).
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3. Asaresult, this event will be highlighted in red, and if it is the first alarm, the Alarms protocol tab will become available

(3). For the alarm which was triggered by the operator, the Marked by the operator cause of alarm is displayed (4).

M763K0163

Par

ONLINE MONITOR

Value

Server status

l K673YK163

LPR channel 1
2020-07-13 12:02:29

M763K0163

LPR channel 1
2020-07-13 12:02:28
Marked by the operator:

¢ LPR channel 1

Recognizer

LPR channel 1

Country

|Russia

Recognition time

|2l]2l]—[)?—13 12:02:28

Speed

[37 km/h

Speed limit

|40 km/h

Validity

|80 %

Direction

[To camera

Cause of alarm

|Marked by the operator:

Regional code

l163

l E339HO163

2020-07-13 12:02:09

l M843BA163

LPR channel 1
2020-07-13 12:02:04

Camera

|Camera 1

() Note.

E [ BM59863
- Q

E b{lr

Search Video archi Filter

For the information about alarms protocol, see Viewing the alarms protocol.

Manual alarm triggering is complete.

3.3.5.2 Viewingthe alarms protocol

The Alarms protocol tab located in the upper area of the Online monitor window (1) automatically becomes available in case of
the alarm event. The alarms protocol is a table which contains the information about the vehicles for which the alarms were

triggered (2).

() Note.

The information about the last alarm is displayed on the tab.
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= = © :
Processed Show Trace ST
Hide Al

LPR channel 1
2020-07-13 13:29:05
Speed: 474 km/h

M942BY163

LPR channel 1
2020-07-13 13:29:03
Speed: 454 km/h

{ E322¥C163 l
LPR channel 1
Parameter Value 2020-07-13 13:28:48
Recognizer LPR channel 1 Speed: 430 km/h
Country |Russia
Recognition time |2020—0?—13 13:29:05
Speed |4?4 km/h LPR channel 1
i 2020-07-13 13:28:38
Speed limit |40 km/h e
Speeding |434 km/h
Validity |78 %
iy
Direction |To camera e M763KO0163
Cause of alarm |speed: 474 km/h LPR channel 1
2020-07-13 13:28:34
Regional code |163 Speed: 496 km/h -
Camera |camera 1 - 0\ o] wh | g
rin Searc eo archi Filt Comm

The alarms which were not processed by the operator, are highlighted with red, and processed alarms are highlighted with
yellow (see Alarm processing).

() Note.

Any alarm event is duplicated: first, an event message with a recognized LP number is received without an alarm, then
the same message is received with alarm. You can hide the processed events (see Hiding the processed events in the
protocol).

To view the alarms protocol, do the same as to view the identified vehicles protocol (see Viewing the identified vehicles protocol).
The only difference is that for an alarm the information about the alarm reason is also displayed:

1. Marked by the operator - means the alarm is triggered by the operator (the time of triggering is also displayed);
2. Isfound in: <external database name> - means the identified LP is found in the external database;
3. Overspeeding - means the vehicle overspeeding is registered.

Detailed information about an alarm with the alarm reason is displayed in the Last event group (see Viewing the data about the
last identified vehicle). To view the detailed information about an alarm, do the same as to view the information about the event,
registered in the identified vehicles protocol (see Viewing the identified vehicles protocol).

In case the identified vehicle LP is found in the External Plates Database, the information about the vehicle, stored in this base,
will be displayed in the field (3).

(@ Note

To display the side panel, click the (4) button.
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A232CX163

Parameter

Value

ONLINE MONITOR

i
= 'M843BA163

LPR channel 1
2020-07-13 13:29:05
Speed: 474 kmih

Recognizer

LPR channel 1

Country

|Russia

Recognition time

|2I}20—0?—13 13:29:05

Speed

|474 km/h

Speed limit

|40 km/h

Speeding

|434 km/h

Validity

|78 %

Direction

[To camera

Cause of alarm

|S|Jeed: 474 km/h

Regional code

l1623

M942BY163

LPR channel 1
2020-07-13 13:29:03
Speed: 454 km/h

LPR channel 1
2020-07-13 13:28:48
Speed: 430 km/h

LPR channel 1
2020-07-13 13:28:38
Speed: 380 km/h

M763K0163

LPR channel 1
2020-07-13 13:28:34
Speed: 496 kmih

Camera

|Camera i

3.3.5.3 Alarm processing

Alarm processing is done in the following way:

Database:
i

Comment:

Server status
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1. Left-click the alarm in the identified vehicles protocol or in the alarms protocol and click Accept button.
. ONLINE MONITOR

MB843BA163

Par 1¢

Value

416
M843BA163

M843BA163

LPR channel 1
2020-07-13 12:16:23
Speed: 55 km/h

Recognizer

LPR channel 1

Country

|Russia

Recognition time

|2l]2l}—0?—13 12:16:23

Speed

|55 km/h

Speed limit

|40 km/h

Speeding

|15 km/h

Validity

|86 %

Direction

[To camera

Cause of alarm

|Speed : 55 km/h

Regional code

163

BCO1763
LPR channel 1

2020-07-13 12:16:13
Speed: 51 km/h

M763K0163
LPR channel 1

2020-07-13 12:15:47
Speed: 52 km/h

M843BA163
LPR channel 1

2020-07-13 12:15:23
Speed: 55 km/h

BCO017133

Q =

Video archive

e [0

ONLINE MONITOR

Server status

| = | a15
== 1 M343BA163

[—Mm‘i&—]

LPR channel 1
2020-07-13 12:16:23
Speed: 55 km/h

Par 't

Value

Recognizer

LPR channel 1

Country

|Russia

Recognition time

|2l]2l]—0?—].3 12:16:23

Speed

|55 km/h

Speed limit

|40 km/h

Speeding

|15 km/h

Validity

|86 %

Direction

[To camera

Cause of alarm

|Speed : 55 km/h

Regional code

163

BCO1763

LPR channel 1
2020-07-13 12:16:13
Speed: 51 km/h

M763K0163

LPR channel 1
2020-07-13 12:15:47
Speed: 52 km/h

MB843BA163

LPR channel 1
2020-07-13 12:15:23
Speed: 55 km/h

BC017133

=

Video archive
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Alarm processing is completed.

3.3.5.4 Hiding the processed events in the protocol

Itis possible to hide the processed events in the identified vehicles protocol and alarms protocol. To do this, click the Processed
Hide button. As a result, when all alarms are processed, then the Alarms protocol tab becomes hidden.

ONLINE MONITOR Server status

® a
Alarm

— 415
== ' M843BA163

LPR channel 1
2020-07-15 12:16:23
Speed: 55 km/h

BCO1763

LPR channel 1
2020-07-15 12:16:13
Speed: 51 km/h

M763K0163
| Parameter Value
" 3 LPR channel 1
Recognizer LPR channel 1 2020-07-13 12:15:47
Country |Russia Speed: 52 km/h
Recognition time |2l]2[l—l}}‘—13 12:16:23
|55 km/h M843BA163

|4l] LT LPR channel 1
15 km/h 2020-07-13 12:15:23
| L Speed: 55 km/h

|86 %

[To camera

|Speed: 55 km/h
Regional code |163

BCO17133

3.3.5.5 Viewingthe alarm information in the Alarm window
Depending on the certain configuration, the Alarm window can be displayed automatically in the following cases:

1. Ifthe recognized license plate number coincides with the number stored in the external online monitoring database. As a
result, the Report of vehicle found in DB ;o || be displayed at the top of the alarm window.

2. Ifthe alarm event was triggered manually. As a result, the Marked by the operator: sign will be displayed at the top of
the alarm window.
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Report of vehicle found in DB Alams in total: 25
f 2018-08-29 17-50-37
Licenze plate KE&73¥K163
Recognition server LPR channel 1
Direction To camera
Intemal Vehicles DB Extemal Plates DB 1
\Etate: Mot corfimed j
Field Value N
a2c98cbf-99ab-e811-aa18-1c1b0da7b3dS
Licensze plate number | Ke7avK162
Storage time [ 2
Active for search | Yes
Datestime of creation |25.08.2018 17:42:08
Comment [
Epieratnr _ _J
-]
[*) 4 5 B
C<< < > >>) Follow Approve (infarmation sent) Dizapprove

The following data is displayed in the Alarm window:

1. Eventinformation (1):
« Date and time when the alarm event was recorded.
« License plate number.
+ Recognition server name that recorded the event.
« Vehicle direction of movement relative to the camera.
« Name of the external database.

(@ Note

The field with the name of the external database is hidden if the the alarm event was triggered manually.

« Current state of the alarm event.

(@ Note

There can be the following states of the alarm event:

+ Not confirmed - a new event that has not yet been confirmed.

+ Processing... - an alarm event is confirmed, but the information has not yet been recorded to the
database.

+ Confirmed - the alarm is confirmed and recorded to the database (you may not notice this state
since the event is deleted from the Alarm window after a successful confirmation).

« Error - the confirmation is not recorded to the database due to the heavy load on the Server. It is
necessary to confirm the event again.

2. The description from the stolen vehicles database (2): ID, LP number, storage time, search status, date and time of
creation, comment, full name of the operator who created the report.
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(@ Note

The table with the description from the stolen vehicles database is hidden if the the alarm event was triggered
manually.

Use buttons to scroll the alarm events (3).

To confirm the active alarm status, click the Approve (information sent) button (5). As a result the alarm will be marked as
received in the On-line monitor window, and deleted from the Alarm window. If the Follow checkbox is set (4), the confirmed
alarm will be deleted from all Alarm windows in the distributed system.

To close the window of stolen vehicle report click the Disapprove button (6). If you click this button, the alarm status will not be
changed in the On-line monitor (alarm will not be processed).

3.3.6 Adding comments to the events

Itis possible to add the comments to the events. It can be done in the Online monitor window.

& Attention!

It is not possible to add the comments to the accepted events (highlighted with yellow).

To add a comment to the event, do the following:

1. Left-click the eventin the identified vehicles protocol or events protocol. Online update of the protocol displayed on the
screen will be suspended.

ONLINE MONITOR Server status

431
% MB43BA163

M942BY163

LPR channel 1
2020-07-13 12:23:15

C011111

. LPR channel 1

2020-07-13 12:23:12
M942BY163 ¢

l BC01763

- LPR channel 1
Recognizer LPR. channel 1 2020-07-13 12:23:12

Par it Value

Country |Russia

Recognition time |2l]2l]—0?—13 12:23:15
Speed 47 km/h 5 E034CP63
Speed limit |40 km/h = B

Speeding |7 km/h o 2020-07-13 12:23:09

Validity 80 % i :
Direction [To camera
Regional code |163
Camera |Camera 1

E322YC163

2. Click Comment button.

Using the Auto-Intellect software system - 28



Operator's Guide

3. Comments for license plate window will open in result.

>

In the Enter new comment field (1), specify a required comment.
5. Click the Add button (2) to add the comment to the event.

(@ Note

The Comments for license plate <LP number> field (3) displays the previous comments, if any, and the date
when they were added to this event.

6. To view the comments to the event, left-click the required event in the identified vehicles protocol or events protocol.
Comments will be displayed in the corresponding field (1).

(@ Note
To display the side panel, click the (2) button.
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M942BY163

ONLINE MONITOR

a3
# M763K0163

M942BY163

LPR channel 1
2020-07-13 12:23:15

Par 't

Value

Recognizer

LPR. ch

Cco11111

LPR channel 1
2020-07-13 12:23:12

BC01763

LPR channel 1
2020-07-13 12:23:12

Database:

‘Comment:

{13-07-2020 12:24:22;
Comment
13-07-2020 12:24:51:
New comment

Server status

Country |Russia

Recognition time |202D—0}'—13 13:33:15

Speed |47 km/h [ E034CP63

Speed limit |4D km/h LPR channel 1

Speeding 7 km/h 2020-07-13 12:23:09

Validity |80 %

Direction [To camera
l163
|Camera 1

Adding the comments to the event is completed.

3.3.7 Printing and exporting the vehicle data

Printing and exporting the vehicle data is done in the following way:
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1. Left-click the event in the identified vehicles protocol or events protocol. Online update of the protocol, displayed on the

screen, will be suspended.

. mm |
— -

ONLINE MONITOR

Parameter | Value

Recognizer |L9R channel 1

Country |Russia

R it i |2022—01-20 09:25:17

Speed |5 km/h

Speed limit |60 km/h

validity |87 %

Direction |me camera

Regional code |07

Camera |Camera 1

Server status

X055BX07

LPR channel 1
2022-01-20 09:25:22

AG14EPO7

LPR channel 1

'_ 2022-01-20 09:25:17

A470KPO7

LPR channel 1
2022-01-20 09:25:16

l

AD100015

LPR channel 1

" 2022-01-20 09:25:17

l

03250007

LPR channel 1

2. To build a report with vehicle data, click the Print button (1), which is located in the left corner of the bottom panel.

Using the Auto-Intellect software system - 31



Operator's Guide

3. The report preview program will be displayed.
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o Intellect

Vehicle data
Recopnizer LPE. channe] 1
Country Fussiz
Eecognition tme 2022-01-2009:27:24
Speed 7 kmh
Speed limit 60 kmh
Validity 10%
Direction From camers
Repional code 07
Cametz Cametz 1

LPE. channe] 1

2022-01-20 092724

A614EP07
(7 km/h)
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If necessary, do the following operations with the report, then quit the report preview program by clicking the File -> Exit

viewer in the main menu, or by clicking the K button in the top right corner.
The available operations for the report are listed in the table below.

Operation

Open the report, saved in .rsd or .xml

Save the reportin .rsd or .xml

Export the report to one of the common formats

Print the report

Activate the «<Hand» tool

Zoom in the report pages

Zoom out the report pages

Enable dynamic scaling of report pages

Zoom in the selected area of the report

Scale in page size

Scale in page width

Display pages in real size

Enter or select from the list the required scale of

displaying the report pages

Enable the nonstop paginal report displaying

Enable the page-by-page report displaying

Go to the first page

Go to the previous page

Go to the next page

Go to the last page

Main menu -[item

File -> Open

File -> Save

File -> Export

File -> Print

View -> Scrolling

View -> Zoom in

View -> Zoom out

View -> Dynamic scaling

View -> Region scaling

View -> In page size

View -> In page's width size

View -> Real size

View -> Set the scaling

Navigate -> The first page

Navigate -> Previous page

Navigate ->The next page

Navigate ->The last page

Operation invocation

Context menu -+item

Scrolling

Zoom in

Zoom out

Dynamic scaling

Region scaling

In page size

In page's width size

Real size

Set the scaling

The first page

Previous page

The next page

The last page

Toolbar
button

P CE

3

W

g5 % -

je=
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Operation

Go to the certain page (open the «Go to page»
dialog window)

Display the previous view

Display the next view

Find the required characters in the report

Update the report

Edit the report (open the editing program)

Display table of contents

Display information about the program to view the
report

Close the preview report program

() Note.

Main menu -item

Navigate -> Go to page

Navigate -> Back

Navigate -> Forward

Document -> Find

Document -> Update

Document -> Edit the report

Help -> About program

File -> Close

Operator's Guide

Operation invocation

Context menu +item Toolbar
button

Back

Forward

Find ﬁ

Update =

Edit the report i

: (=

Operations with report files (opening, saving, exporting, and printing) are performed via the standard 0S

Windows dialog windows.

(@) Note.

To go to the required page, enter the page number in the Page Ne field of the Go to page dialog window and

then click OK.

Printing and exporting the vehicle data is completed.

3.3.8 Viewing the video archive by event

You can view the video archive by event from a video camera which is used for the license plate recognition.

() Note

For this feature to work, the appropriate monitor should be selected on the settings panel of the Vehicle Tracer object

(see Selecting the Monitor object for playing back the video archive).

To view the video archive by event, do the following:
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1. Select an event in the identified vehicles protocol or alarms protocol by left-clicking on it. As a result of the operation, the
online update of the protocol displayed on the screen will be suspended.

ONLINE MONITOR Server status

| &= 470
= s M763K0163

E322¥C163

LPR channel 1
2020-07-13 12:37:57

E183MC163

LPR channel 1

| e y 2020-07-13 12:37:53
K673¥YK163 J ‘ s ;

l ¥Y500¥YH63

Par 10 Value

: LPR channel 1
Recognizer LPR channel 1 | 2020-07-13 12:37:48

Country |Russia
Recognition time [2020-07-13 12:37:45 -
Speed |47 km/h ; [ K673YK163

Sl |4ﬂ K/ F LPR channel 1
|7 km/h |- 2020-07-13 12:37:45

Speeding
Validity |83 %
Direction [To camera
Regional code |163

Camera |Ca mera 1

M763K0163

2. Click the Video archive button.

« If the Monitor object is selected for the video archive playback, the video surveillance window of the
corresponding monitor will switch to the archive playback mode. For details on working with the video archive, see
the Intellect Operator's Guide, the most current version of the documentation is located in the AxxonSoft
documentation repository).

« If the AxxonNext monitor object is selected for the video archive playback (see Setting up the joint operation of
Auto Intellect and Axxon Next), the Axxon Next interface window will open in the archive playback mode. For
information on working with the video archive, see the Axxon Next Operator's Guide, the most current version of
the documentation is located in the AxxonSoft documentation repository).

Viewing the video archive by event is completed.

3.3.9 Usingfilters in the protocols

You can select events to be displayed in the identified vehicles protocol and alarms protocol.

A Attention!

Both displayed and hidden in the protocol events are saved in the recognizers database of the Auto Intellect software.

You can select the events using the following filters:

1. speed;
overspeeding;
license plate;
validity;
region;
direction;
alarm type;

Nouohkwn

Using the Auto-Intellect software system - 36


https://doc.axxonsoft.com/confluence/display/ASdoc/AxxonSoft+documentation+repository
https://doc.axxonsoft.com/confluence/display/auto60en/Setting+up+the+joint+operation+of+Auto+Intellect+and+Axxon+Next
https://doc.axxonsoft.com/confluence/display/ASdoc/AxxonSoft+documentation+repository

Operator's Guide

8. plate recognizers.
To select the filter, do the following:

1. Click Filter button in the On-line monitor window (1).
ONLINE MONITOR

E322¥C163

LPR channel 1
2020-07-13 12:37:57

l E183MC163

LPR channel 1

2020-07-13 12:37:53
K673¥YK163 -

l ¥Y500¥YH63

. i LPR channel 1
Recognizer LPR channel 1 | 2020-07-13 12:37:48

[Par 10 Value

Country |Russia

Recognition time |2l]2l]—l}}‘—13 12:37:45

Speed |47 km/h | l K673¥YK163

Speed limit |4[l km/h | LPR channel 1

Speeding 7 km/h L 2020-07-13 12:37:45

validity 83 % _

Direction [To camera
l163

|Cameta 1

M763K0163
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2. Filters dialog window will be displayed in result.

Speed, kmfh

I Mo filkering

Speeding, kmyf'h

I Mo filkering

License plate

| Mo filtering

Validity

| No filtering

Region

I Mo filtering

Directicn

I Mo filtering

Alarm type

I Mo filkering

Plates recognizers

Operator's Guide

3. Fromthe Speed list (1) select the required filter, then specify the speed value(s) in the field(s) in km/h.

The following speed filters are available:
+ No filtering — the event is displayed in protocols with any vehicle speed.

+ More — the event is displayed in protocols if the vehicle speed exceeds the specified value.
+ Less —the event is displayed in protocols if the vehicle speed is below the specified value.
+ Interval — the event is displayed in protocols if the vehicle speed is within the specified speed range.

() Note

Available range for specifying the Speed filter values is 0-300.
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4. From the Speeding list (2) select the required filter, then specify the overspeeding value in the field in km/h.
The following overspeeding filters are available:
+ No filtering — the event is displayed in protocols with any vehicle overspeeding.
« More — the event is displayed in protocols if the vehicle overspeeding exceeds the specified value.

() Note.

The overspeeding value is calculated as the difference between the recorded vehicle speed and the
speed, permitted in the controlled area of the road.
Available range for specifying the Speeding filter values is 0-100.

5. From the License plate number list (3) select the required filter and then in the field enter the LP number or its part which
identification leads to event displaying in protocols.
The following LP filters are available:
+ No filtering — the event is displayed in protocols with any vehicle LP number.
« Register — the event is displayed in protocols if the vehicle LP number exactly matches the specified value.
« Contains — the event is displayed in protocols if the vehicle LP number contains the specified value.

() Note.

The value specified for the Register and Contains filters may include usual characters and «*» characters
which stand for an unidentified LP character. If the value contains one or several «*» characters, only the
LPs which contain the unidentified characters in the specified combination, are displayed in the
protocols.

6. From the Validity list (4) select the required filter of the LP recognition validity percentage, then specify the percentage
value in the field(s).
The following validity filters are available:
+ No filtering - the events are displayed for those vehicles which plates are recognized with any validity.
« More - events are displayed in the protocol if the recognizing validity is higher than the specified value.
« Interval - vehicle event is displayed in the protocol if the recognizing validity of vehicle plate belongs to the
specified range of values.

() Note
Available range for specifying the Validity filter values is 0-100.

7. From the Region list (5) select the required region filter, where the vehicle has been registered, and then enter the region
number in the field.
The following region filters are available:
+ No filtering — the events are displayed in protocols for the vehicles, registered in any region.
« Equal — the events are displayed in protocols for the vehicles, registered in the specified region.
8. From the Direction list (6) select the vehicle direction for which the event should be displayed in protocols.
The following direction filters are available:
+ No filtering — the events are displayed in protocols with any vehicle direction.
« From camera — the event is displayed in protocols if the vehicle was moving away from the camera.
+ Towards the camera — the events are displayed in protocols if the vehicle was moving towards the camera.
« Undefined — the events are displayed in protocols if the vehicle direction was not determined.
9. From the Alarm type list (7) select the alarm type. Only alarms of the selected type will be displayed in protocols.
The following alarm type filters are available:
+ No filtering — the events are displayed in protocols with any alarm type or its absence.
« Overspeeding — the events for which overspeeding has been registered are displayed in protocols.
« LP found in database — the events for which the LPs have been found in the external plates database are
displayed in protocols.
« Alarm set by operator — the events, initialized manually, are displayed in protocols.
« Running ared light — the events for which the red lights running has been registered are displayed in protocols.
+ Entered the oncoming lane — the events for which the entering the oncoming lane has been registered are
displayed in protocols.
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+ Crossed the stop line — the events for which the crossing the stop line has been registered are displayed in
protocols.
+ Stop over crosswalk line - the events for which the stopping on the crosswalk line has been registered are
displayed in protocols.
10. Inthe Plates recognizers (8) group set the checkboxes for those LP recognition Servers, which data should be displayed
in protocols.
11. Click OK to save filters settings and close the Filters dialog window (10).

(@) Note.
To reset all the settings, click the Reset button (9).

Filtering the events to be displayed in the protocols is complete.

() Note

You can disable any filtering without changing the settings in the Filters dialog window. To do this, click the Show all
button (2). All the registered events will be displayed in protocols in result. To resume the usage of filters, click this
button again.

3.3.10 Viewing the Vehicle Tracer errors

If there are no Vehicle Tracer errors, the Server status button in the right upper corner of On-line monitor window is green

Server status

Server status

270
= M763K0163

E322¥C163

LPR channel 1
2020-07-13 12:37:57

=) e ﬂ?;rw‘” w o
o :

[ E183MC163

LPR channel 1

' i . 2020-07-13 12:37:53
K673VK163 B EEE :

[ ¥500¥YH63

Parameter Value

" | o LPR channel 1
Recognizer LPR. channel 1 ; 2020-07-13 12:37:48

Country |Ru ssia
Recognition time |2020-07-13 12:37:45 .
Speed |47 km/h | e [ K673YK163

SncedTang |4l] A S LPR channel 1
|7 km/h | . 2020-07-13 12:37:45

Speeding
validity |83 %

Direction [To camera o
Regional code 163 M763K0163

Camera |Ca mera 1 &
i Video archive

To view the Vehicle Tracer errors, do the following:

1. Click the Server status button.
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2. The Errors dialog window will be displayed in result.

3. The data about the occurred errors is displayed in the field (1).

4. Thelist of all possible error sources is displayed in the field (2): LPR channels and/or external databases. Current error
sources are marked by the @ sign, idle sources are marked by the @ sign.

5. To delete the data about the errors and close the Errors dialog window, click the Clear button (3).

6. To close the Errors dialog window without deleting the data about the errors, click the . button.

Viewing the Vehicle Tracer errors is completed.
3.3.11 Creating the additional Online monitor components

Itis possible to create the additional Online monitor interface components. To do this, double left-click the Events monitor
component. As a result, the additional Online monitor component will be displayed in the center of the screen.
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ADDITIONAL ONLINE MONITOR - 1 (LPR channel 1)

Server status n X

0o

Show
All

E
! Alarm

MB43BA163

| B

LPR channel 1
2020-07-13 12:49:19

l BM59863 l
LPR channel 1
2020-07-13 12:49:18
MB843BA163
l A232CX163 l
LPR channel 1
Parameter |\ra|ue 2020-07-13 12:49:14
Recognizer |LPR channel 1
Country |Ru ssia
Recognition time |2l]2l]—0}‘— 13 12:49:19 l MO42BY163 l
Validity |86 % LPR channel 1
G h—o ETEE 2020-07-13 12:49:12
Regicnal code |163
Camera |camera 1
[ Cc0o11111 l
LPR channel 1
- 2020-07-13 12:49:09
& & S -
Search ideo archive Filter Cornment_

Working with Additional Online monitor components is similar to working with the main Online monitor component.

3.3.12 Searchingthe events in the recognizers databases

3.3.12.1 Openingand closing the Event search in the Recognizers DBs window

On this page:

« General info about searching the events in the recognizers databases
« Opening and closing the Event search in the Recognizers DBs window
« Opening the Event search in the Recognizers DBs window using the Windows command line

3.3.12.1.1 Generalinfo about searching the events in the recognizers databases

You can search the events in the the Auto Intellect recognizers databases via the Event search in the Recognizers DBs dialog

window.

The full list of operations provided to the operator in the window Event search in the Recognizers DBs, is the following:

1. Searching the events, stored in the Auto Intellect local or remote recognizers databases.

2. Printing the search results reports.
3. Creating the personal LPs database (Active tracking database).
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3.3.12.1.2 Opening and closing the Event search in the Recognizers DBs window

To open the window, click the Search button in the Online monitor interface object.

ONLINE MONITOR

I Parameter

Value

Recognizer

LPR. channel 1

Country

|Russia

Recognition time

|202l]—l]7—13 125442

Validity

|80 %

Direction

|[To camera

Regional code

|163

Camera

|Camera il

Partly recognized
"Space’in car number

Acceptable emor amount

View  Settings  Servers  Internal SVDBs
Print

Export...

Exit3 AND -
%666%

[] License plate net recognized

§ 42
*=7 K673YK163

i
Alarm
l

A232CX163

LPR channel 1
2020-07-13 12:54:45

[ MO42BY163

LPR channel 1
2020-07-13 12:54:43

| 2020-07-13 12:54:40

[ BC017131

LPR channel 1
2020-07-13 12:54:40

[ BC01763

LPR channel 1

[ E034CP63

LPR channel 1
2020-07-13 12:54:37

1] from | 1
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To minimize the Event search in the Recognizers DBs window, click the (1) or (2) buttons. As a result, the window will be
minimized to the Taskbar but will continue working.

To close the Event search in the Recognizers DBs window, select the File — Exit item in the main menu (3). As a result, the
window will be closed completely.

3.3.12.1.3 Opening the Event search in the Recognizers DBs window using the Windows command line

The Event search in the Recognizers DBs window can also be opened using the Windows command line, even when the Intellect
is unloaded. To do this, run the following command:

<Intellect 1dinstallation directory>\Modules>VehiclePlateSearch.run "C:
\Users\<Username>\AppData\Local\Temp\PlateSearchSettings_1.xml"

Command example:

C:\Program Files (x86)\Intellect\Modules>VehiclePlateSearch.run "C:
\Users\User\AppData\Local\Temp\PlateSearchSettings_1.xml"

"C:\Users\UserName\AppData\Local\Temp\PlateSearchSettings_1.xml" - is the path to the PlateSearchSettings_1.xml
configuration file, which is generated each time you click the Search button in the Online monitor interface window in
accordance with the current system configuration. If the system configuration has changed, then to re-generate the file, click the
Search button again or make changes to the file manually.

() Note

If you work in the Event search in the Recognizers DBs window with the Intellect unloaded, then the vehicle frames
and license plate images will not be displayed.

3.3.12.2 Configuring the events search

On the page:

+ Selecting the
recognizer
databases for the
events search

« Configuring the
search results

« Configuring the
video archive

Events search is set up in the following order:

1. Select the database, where events should be searched.
2. Configure the displaying of search results.
3. Configure the video archive.

3.3.12.2.1 Selecting the recognizer databases for the events search

To select the recognizer databases for events search, first select the servers where the required LPR databases are. To do this, in
the main menu of the Event search in the Recognizers DBs window, in the Servers item, select the required server names. To
select all system servers, click Servers — Select all.
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24 Event search in the Recognizers DBs

File View  Settings | Servers | Internal SVDEs

®

Search by vehicles | Search

Vehicle's license plate: (

Select all

LOCALHOST[127.0.0.1:10001:]

—

Note.

Each time you open the Event search in the Recognizers DBs window, the access to the selected servers is checked. If
any of the selected servers is unavailable, then after the timeout expires, the header of the search results table will
display a list of servers to which it was not possible to connect, and the header itself will be highlighted with red. If all
servers are available, the header will be highlighted with green.

The timeout for connecting to the selected Auto Intellect servers is set on the settings panel of the Vehicle Tracer
module window (see Setting up the Vehicle Tracer interface window).

3.3.12.2.2 Configuring the search results

Event search results are displayed in the table. You can choose which table columns should be displayed and which shouldn't,
add new columns and also edit the columns displayed names.

To configure the search results displaying, do the following:

1.

In the main menu of the Event search in the Recognizers DBs, click Settings.

24 Event search in the Recognizers DBs

File View CSettings ) Servers  Internal SVDBs

Search by vehicles | Search by alams |

As a result the Settings dialog window is displayed. The search results displaying is configured on the Configure fields
tab.

[ Settings @

Corfigure fields | Configure video archive

-

Frame Add ]
License plate
[] Mumber Edit ]

Regional code

LP region
Recognizer name
Vehicle speed
Country

Date

Recognizer address
[] Valid speed, km/h
Speeding, kmsh
Direction

Validty, %

Alam time

Alam inttiated by
Alam accepted by j

:! Select deselect
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In the field (1) set the checkboxes for the columns that should be displayed in search results table.

() Note.

To display all the available columns in the search results table, set the Select\deselect checkbox (2). If this
checkbox isn't set, the search results table is not displayed.

Column name (by default)

Frame

License plate
Number

Region number

LP region
Recognizer name
Vehicle speed
Country

Date

Recognizer address
Valid speed, km/h
Speeding, km/h
Direction

Validity, %

Alarm time

Alarm initiated by
Alarm accepted by

Comment from external DB

Alarm accepted at
Alarm handing delay, sec
Comment

Alarm type

Alarm processed
External DB

Red-light phase start time

Column content

Video frame with a vehicle

Video frame with vehicle LP number

Identified LP number

Region number of the identified number

Region of the identified LP number

LPR channel object name, corresponding to the vehicle detector
Vehicle speed

The country of the recognized LP number

Date and time of the vehicle identification

LP detector address

Speed in km/h permitted on the road area covered by the detector
Vehicle overspeeding in km/h

An indication that the vehicle was moving towards the detecting camera
LP identification accuracy in percent

Time of the LP detection alarm registration

Name of the operator who initiated the alarm

Name of the operator who processed the alarm

Comment on the vehicle report in the external plates DB added by the
operator

Time of the LP detection alarm acceptance by the Auto-Intellect operator
Time between registering the alarm and its acceptance by the operator
Comment on the event added by the operator

Alarm type (overspeeding or vehicle identification in the external plates
databases)

An indication that the alarm was accepted by the operator

An indication that the alarm was found in the external plates database

Time of the red-light phase start during which the alarm was registered (if the

Red lights running module is used)
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Time passed since the red-light phase start

Category

Camera

Type

Vendor
Model
Frame from a synchronous camera

Dangerous goods class

Dangerous goods composition
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Column content

Time between the red-light phase start and the alarm registration (if the Red
lights running module is used)

Vehicle category identified by license plate
Name of the video camera which captured the vehicle

Vehicle type (if the Vehicle type recognition module and/or the RoadAR
vendor and model recognizer are used)

Vehicle vendor (if the RoadAR vendor and model recognizer is used)
Vehicle model (if the RoadAR vendor and model recognizer is used)
Video frame from a synchronous video camera displaying a vehicle

Class of the dangerous cargo (if the CARMEN-Auto module and the Hazard
Identification Number Recognition Engine (ADR) are used)

Contents of the dangerous cargo (if the CARMEN-Auto module and the
Hazard Identification Number Recognition Engine (ADR) are used)

3. Toadd a new column to the search results table, do the following:
a. Click Add (3). As the result the Configure fields dialog window will be displayed.

Configure fields

Field name in the DEB:

(3]

Field name in the inteface:

2

Save

3

| I Cancel

4

b. Inthe Field name in the DB field, specify the name of the column in the connected recognizer database, which
content should be displayed in the search results table (1).
c. Inthe Field name in the interface field, specify the name for this column which should be displayed in the search

results table (2).

d. Click Save to save the applied changes and close the Configure fields dialog window (3).

() Note.

Click Cancel to close the window without saving any changes (4).

4. To edit the column name in the search results table, do the following:
a. Inthe Configure fields group select the column, which name should be changed (1).

b. Click Edit (4).

c. Asaresult the Configure fields dialog window with the disabled Field name in the DB field is displayed.

Configure fields

Field name in the DB:
frames preview_frame

Field

[

I Save

| I Cancel

d. Inthe enabled Field name in the interface field, specify the new column name and save the changes (see steps

4.3-4.4).
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5. Click OK to save the changes and close the Configure fields dialog window (5).

() Note.

Click Cancel to close this window without saving any changes (6).

Configuring the displaying of the search results is completed.

3.3.12.2.3 Configuring the video archive
Video recordings of the events are displayed in the video archive. To configure the video recordings playback, do the following:

1. Inthe main menu of the Event search in the Recognizers DBs, click Settings.

ﬂ Event search in the Recognizers DBs

File View Servers  Internal SVDBs

| Search by vehicles | Search by alams i

As a result the Settings dialog window is displayed.
2. Go to the Configure video archive tab (1).

Settings @

rCDI‘I‘figIJI‘E.' fiiglds |
Cveray

| Overtay 2 |2

Corfigure video anchive | 1

f: Compression

U

Default Mone Mazdmum

4
0K || cancel |

3. From the Overlay drop-down list, select the Overlay mode (2).

() Note.

Overlay is used to process the video using the video card and Direct X libraries, before it is displayed. Overlay
allows to improve the image due to optimization of the pixel color settings. At the same time, the CPU load is
reduced as the video is processed with the resources from the video capture card.

The overlay modes are presented in the table.

Overlay mode Description

No Videos from the video cameras are not processed by the video card.
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Overlay 1 Videos from the video cameras are processed as one stream.

Overlay 2 (set by default) Videos from the video cameras are processed independently of one another.

4. Inthe Compression field, set the cursor according to the required video compression rate (3).
« Default — means the original compression rate, size and quality of the video corresponds to the video image that
is sent to the server.
« None — means minimal compression rate, full video size, best quality.
+ Maximum — means maximum compression rate, minimal video size, worst quality.
5. To save changes click OK (4).

The configuring of the video recordings playback is completed.

3.3.12.3 Creating the search query

On the page:

 Creating the search
query by
recognized vehicles

+ Creating the search
query by alarms

« Query launching

It is possible to form a search query:

1. Byrecognized vehicles (Search by vehicles tab) ;
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2. y alarms (Search by alarms tab).

File View Settings Servers  Internal SVDBs

Search by vehicles | Search by alams

Vehicle's license plate:

Search operation:

[] License plate not recognized

Parthy recognized

"Space’in car number

Acceptable emor amount
Report type

[ Passes

Interval before/after, sec

Min. number of occumences

Regional code:

motspeciﬁed)
i
163

LP region:

<not specified>

LP colors:

<not specified>

3.3.12.3.1 Creatingthe search query by recognized vehicles
To create the search query by recognized vehicles, do the following:

1. Go to the Search by vehicles tab.

2. Inthe Vehicle's license plate group:
Wehicle's license plate:

Search operation: 1

ATTTAA 2
[ ] License plate not recognized 3

Parthy remgnized4

"Space’in car number 5

Acceptable emor amount 6
Report type
| Escort vehicles -7

Interval before/after, sec 8
Min. number of occumences 9
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From the Search operation list (1) select a logical construction, used for uniting several elements of the key
phrase, which correspond to the LP numbers or their parts that are being searched:

« AND - for searching by numbers, containing all the elements of the key phrase;

« OR -for searching by numbers, containing at least one element of the key phrase.
In the (2) field, enter the key phrase. The elements of the key phrase can be separated by comma "," or semicolon

() Note.

The key phrase may include usual characters and picture-characters in the required combination.

Picture-characters Description of Picture- Example of search query
characters
% Any string in length from zero and more Search query a%385%78 returns LP numbers,
characters containing the elements 'a’, '385' and '78', divided by
any number of characters, for example 'AO38578',
'a385mk78'
_ (underlining) Any single character Search query 2__5 returns LP numbers, containing the

sequence of four characters, the first of which is '2', the
last oneis '5',for example, 'A256577', '21150K43'

{1 Any single character within the range ([a-€]) Search query [e-m][2-5]53 returns LP numbers,
orin the set ([abcde]) containing the sequence of four characters. The
sequence ends in '53', the first character belongs to the
range e-m, the second one belongs to the range 2-5, for
example, 'k453mn02', 'm253bt63'

[ Any single character outside the range ([*a- Search query [*e-m]499 returns LP numbers, containing
e]) or the set ([*abcde]) the sequence of four characters. The sequence ends in
'499', the first character does not belong to the range e-
m, for example 'b499bk57', 'n499578'

. Set the License plate not recognized checkbox (3) if it is necessary to display all the numbers.

() Note.

Selection of the checkbox License plate not recognized is enabled only if the OR logical construction is
selected in the Search operation drop-down list.

. Set the Partly recognized checkbox if it is necessary to display partially recognized numbers (4).

e. Setthe 'Space' in car number checkbox (5) if it is necessary to display the numbers that contain a space between

the characters.
. Set the Acceptable error amount check box (6) to display the numbers with the errors (character mismatches),
the amount of which is indicated in the drop-down list.
From the Report type drop-down list (7) select the type of vehicle search:

i. Passes - standard search.

ii. Escortvehicles - search for all vehicles that have been recorded near the specified vehicle within the time

interval set in the Interval before/after, sec parameter.

In the Interval before/after, sec field (8), specify the time in seconds within which it is necessary to to search for
the vehicle.

() Note

This parameter is available if Escort vehicles value is selected in the Report type drop-down list.

In the Min. number of occurrences field (9), specify the minimum number of vehicle records within the time set in
the Interval before/after, sec parameter.

() Note

This parameter is available if Escort vehicles value is selected in the Report type drop-down list.
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In the Regional code group set the checkboxes for those regional codes events for which should be returned while being

3.
searched.
Regional code:
[ <not specified= -
[ 1
[] 163 -

A Attention!
Only those regional codes are displayed, the license plate of which has already been recognized earlier, since this
information is received from the database of recognized license plates.

4. Inthe LP region group set the checkboxes for those regions, which events should be returned while being searched.
LP region:
[ <not specified>

A Attention!
Only those regions are displayed, the license plate of which has already been recognized earlier, since this
information is received from the database of recognized license plates.

5. Inthe LP colors group select color of regional code and basic color of the license plate.

LP colors:
[] <not specified=

() Attention!
Only those license plate colors are displayed, the license plate of which has already been recognized earlier,
since this information is received from the database of recognized license plates.

In the Date/time group set the time range within which the required events have been registered. By default this range is
not activated (checkboxes from and to are disabled). To activate it, set the checkboxes From and/or To and then click
[~ button and in the appeared calendar set the required date. Enter the required time in the field From and/or To. If
only upper or bottom boundary is selected, the search query will return the events, registered before or after the set
deadline correspondingly. To disable the search by date and time, uncheck From and To checkboxes.

6.

Date/Time
from: [] 2021-03-10 17:22:58 El~
to: [0 2021-03-10 17:22:58 El~
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7. Inthe Plate recognizers group set the checkboxes for those plate recognizers, which events are to be returned while
being searched.
Plate recognizers:

LPR channel 1

() Note.

By default, information about objects removed from the Intellect software package is not displayed in the Plate
recognizers group. Select Show deleted in the View menu of the Event search in the Recognizers DBs main
window to search by removed servers of plate recognizers.

ﬁ Event search in the Recognizers DBs

Internal SVDBs

v | |y |
After this all removed servers of plate recognizers will be displayed in the Plate recognizers group. Set
checkboxes for those plate recognizers which will be used while being searched.

8. From the list Registered speed select the required filter of vehicle speed and then in the activated field(s) enter the
threshold value(s) of vehicle speed. The following speed filters are available:
Fegistered speed:

<not impaortant = -

P . I

+ <not important> - events of the vehicle, moving with any speed will be returned.
+ More - events of the vehicle, moving with a speed, exceeding a single threshold value, will be returned.
+ Less - events of the vehicle, moving with a speed, not exceeding a single threshold value, will be returned.
+ Interval - events of the vehicle, moving with a speed, belonging to a single entered threshold value, will be
returned.
9. From the Direction list select the required filter concerning the direction of the vehicle. The following direction filters are
available:

Direction: | =zno matter: -

+ <no matter> - events of the vehicle, moving in any direction concerning the LP recognizer's camera will be
returned.
« Undefined - events of the vehicle, which direction could not be defined, will be returned.
+ From the camera - events of the vehicle, moving away from the LP recognizer's camera will be returned.
+ To the camera - events of the vehicle, moving towards the LP recognizer's camera will be returned.
+ To theright - events of the vehicle, moving to the right of the LP recognizer's camera will be returned.
+ To the left - events of the vehicle, moving to the left of the LP recognizer's camera will be returned.
10. Inthe Countries group set the checkbox for the country, which events should be returned while being searched.
Courtries:

[ <not specified=

[ Russia
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A Attention!

Only those countries are displayed, the license plate of which has already been recognized earlier, since this
information is received from the database of recognized license plates.

11. Inthe Comment group:
Commert:

Search operation:  |AND - 1

2

Empty comment 3

a. From the Search operation list (1) select a logical construction, used for uniting several elements of the key

phrase, corresponding to the comments, that are being searched:
+ AND - for searching by comments, containing all the elements of the key phrase;
+ OR - for searching by comments, containing at least one element of the key phrase.

b. Inthefield (2) enter the key phrase, containing one or several comma separated elements, corresponding to the
comments to the events, which are being searched, and which were specified in the Online monitor window (see
Adding comments to the events).

c. Setthe Empty comment checkbox (3) to include the uncommented events in the search.

() Note.

This parameter is available if the OR logical construction is selected in the Search operation dropdown
list.

12. From the Validity list select the required validity filter and then enter the threshold of validity values in percent. The
following validity filters are available:
Validity:

<nat important = -

+ <not important> - events of the vehicle, which numbers have been recognized with any validity.

+ More - events of the vehicle, which numbers have been recognized with validity, exceeding the entered threshold
value in percent.

+ Less - events of the vehicle, which numbers have been recognized with validity, not exceeding the entered
threshold value in percent.

« Interval - events of the vehicle, which numbers have been recognized with validity, belonging to the entered
threshold value in percent.

13. In the Recognition cameras field set the checkboxes for the cameras, which events should be returned while being
searched.
Recognition cameras

| Camera 1

To clear the Search by vehicles tab from the entered search, click the Reset button.

3.3.12.3.2 Creating the search query by alarms
To create the search query by alarms, do the following:

1. Go to the Search by alarms tab.

2. Repeat steps 2-12 of the Creating the search query by recognized vehicles section as applied to interface elements of
the tab Search by alarms.
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3. Inthe External DB group (2) set the checkboxes for those external databases, which events are to be returned while being
searched.
BExtemal DE:

[] Extemal Plates DB 1

() Note.

The External database group contains a list of all the databases that have ever been used together with the
Vehicle Tracer module but, by default, databases removed from the Intellect software package are not displayed
in the list. Select the Show deleted in the View menu of Event search in the Recognizers DBs main window to
search by removed servers of plate recognizers.

a Event search in the Recognizers DBs
File

Settings  Server Internal SVDBs

E| Show deleted

J Sea

L

J m |
As aresult, all external databases removed from the system will be displayed in the list. Set checkboxes for those
databases which will be used while being searched.

4. From the Permitted speed list select the required speed filter, permitted on the controlled road area and then enter the
threshold speed values in km/h. The following filters of the permitted speed are available:
Pemitted speed:

irterval -

= to: |0 =

-

from: |0 -

« <not important> - events of the vehicle, registered on the road area with any permitted speed will be returned.

« More - events of the vehicle, registered on the road area with any permitted speed, exceeding the entered
threshold value will be returned.

+ Less - events of the vehicle, registered on the road area with any permitted speed, not exceeding the entered
threshold value will be returned.

« Interval - events of the vehicle, registered on the road area with any permitted speed, that belong to the entered
threshold value range will be returned.

5. From the list Alarm handling delay, sec select the required filter according to the alarm handling delay and then in the
activated field(s) enter the threshold value(s) of delay time in seconds. The following filters of alarm handling delay are
available:

Alam handling delay, sec

interval - |

= to: |0 =

-

from: |0 =
+ <not important> - alarms, accepted in any time after being registered or unaccepted at all.
+ More - alarms will be returned, accepted with a delay, exceeding the entered threshold value.
+ Less - alarms will be returned, accepted with a delay, not exceeding the entered threshold value.
+ Interval - alarms will be returned, accepted with a delay, belonging to the entered threshold value.
6. From the list Alarm processed select the required filter according to the alarm processing factor:

Alam processed: Zno matter: -

« <not important>— both processed and unprocessed events will be returned.
« Alarm is not processed — only unprocessed events will be returned.
« Alarm processed — only processed events will be returned.

Using the Auto-Intellect software system - 55



Operator's Guide

7. Inthe Alarm accepted by group, set the checkboxes for the operators who received the alarm events to display these
events in the search query.
Alam accepted by

[] <not specified=

(O Note

This parameter is available if the <not important> or Alarm processed value is selected in the Alarm processed
list (see above).

8. Inthe Alarm type group, set the checkboxes for the alarms, which should be returned in results of search query:
Alam type

[#] Alam is set by the operator -
[#] Ertered the oncoming lans

[¥] Marking rules violation

[#] Parking rules violation -

+ Stop over stop line — events will be returned for which stopping over the stop line at the stoplight has been
registered.

+ Entered the oncoming lane — events will be returned for which entering the oncoming lane has been registered.

+ Parking violation — events will be returned for which the violation of parking rules has been registered.

+ Marking rules violation — events will be returned for which the violation of marking rules has been registered.

+ LP found in database — events will be returned which plates have been found in the external database.

+ Stop over crosswalk line - events will be returned for which stopping over the crosswalk line at the stoplight has
been registered.

+ Overspeeding — events will be returned for which overspeeding has been registered.

» Running a red light — events will be returned for which running a red light has been registered.

» Running a red light at crossroads — events will be returned for which running a red light at crossroads has been
registered.

+ Alarm is set by operator — manually triggered alarms will be returned.

9. Inthe Comment from external DB group:
Commert from extemal DB:

Search operation:  |OR - 1
2

a. From the Search operation list (1), select the logical construct which is used to combine several elements of the
key phrase, that correspond to the comments to the events to be searched in external databases:
« AND - to search for comments that contain all the elements of the key phrase;
« OR-to search for comments that contain at least one element of the key phrase.
b. Inthefield (2), enter a key phrase consisting of one or more elements, separated by commas, that correspond
to the comments to the events to be searched in external databases that are specified in the External DB
group (see Creating the Active tracking database).
10. From the Speeding list select the required speeding filter and then enter the threshold values of speeding in km/h. The
following filters of the speeding are available:
Speeding:

interval - |

= to: |0 =

-

from: |0

+ <not important> - events of the vehicle, moving with any overspeeding or with the absence of it will be returned.
+ More - events of the vehicle, moving with overspeeding, exceeding the entered threshold value will be returned.
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+ Less - events of the vehicle, moving with overspeeding, less than the entered threshold value will be returned.
« Interval - events of the vehicle, moving with overspeeding, in the entered range of threshold values, will be
returned.

() Note.

+ This parameter is available if the checkbox Speeding is set in the Alarm type group.
« The value of speeding is calculated as a difference between the fixed vehicle speed and the speed,
permitted on the controlled area of the road.

11. From the Red light shows at, sec list select the required filter for red light start and then in the activated field(s) enter the
threshold value(s) in seconds. The following filters of the running a red light are available:
Red light shows at, sec

interval -

from: |0 = to: |0 =

« <not important> - events of the vehicle, which violated a red light, will be returned.

+ More - events of the vehicle, which violated a red light after the entered threshold value will be returned.

+ Less - events of the vehicle, which violated a red light before the entered threshold value will be returned.

« Interval - events of the vehicle, which violated a red light within the entered range of threshold values, will be
returned.

() Note

This parameter is available if the Running a red light checkbox is set in the Alarm type group.

12. Inthe Alarm initiated by field select the required operators who initiated the alarm. The corresponding alarms will be
shown in the search results.

Alam initiated by

[ <not specified=

() Note

This parameter is available if the Alarm is set by operator checkbox is set in the Alarm type group.

To clear the Search by alarms tab from the entered search, click the Reset button.

3.3.12.3.3 Query launching
After forming the search query by vehicles or by alarms, launch its processing by clicking the Find button.

As a result, a table of search results will be displayed that match the entered conditions:
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Event search in the Recognizers DBs
File  View  Settings Servers  Internal SVDBs

Search by vehicles | Search by alams

Vehicle's license plate: =l

Search operation: m =
Frame from

synchronous License plate Frame Mumber Regional code LP region Re

camera

-h results.

»

[] License plate not recognized
[ Partly recognized

[ "Space’ in car number -
[ Mcceptable emor amount |1_

LF

‘

m

LF

Regional code:

[ <not specified> LF
11

1] 163

— w
4 » FERES Fl

LP region:
[ <not specified>

LF

LF

LP colars:
<nct specified>

LF

(][] fom [ 2

If the Escort vehicles report type was selected, the search results table will look like this:
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File  View  Settings Servers  Internal SVDBs

Search by vehicles | Search by alams
Vehicle's license plate:
Search operation:

KE73YK183

| »

[] License plate not recognized

Fartly recognized

“Space’ in car number

Acceptable emor amount
Report type

[Escort vehicles -]

Interval before/after, sec 1 EI

Min. number of ocoumences =

Regional code:

[ <not specified> o
B 1
] 163 -

LP region:
<not specified>

LP colors:

<nat specified

| (<] -

3.3.12.4 Viewing, printing and exporting the search results

Columns of Search results table (1) are displayed in accordance with the settings, given in the Configure fields dialog window
(see Configuring the events search).

The description of the columns content is given in the same section of the Guide.
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9 ! Search results.

License plate Frame Mumber Plate region E:g;onal E{:ri:gnizer Vehicle speec
LPR channel 1 M
LPR channel 1
LPR channel 1
LPR channel 1

B447ep 19 B447EP190 LPR channel 1

\ .« | i Y,

2 i [ 50

To navigate in the results table, use the following interface elements:

1. button - go to the first page of the table;
2. button - go to the previous page of the table;
3. field I - go to the required page of the table;

4. field - the number of pages in the table;

5. button - go to the next page of the table;
6. button - go to the last page of the table.

(@ Note.
To go to the required page, enter its number in the field (2), and then press Enter on the keyboard.

The search results can be printed or exported as a report (see Printing the search results report), as well as the JPG file (see
Exporting the search results to JPG files).

3.3.12.4.1 Printing the search results report

The event search results can be printed as a report. To do this, follow these steps:
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1. Inthe main menu of the Event search in the Recognizers DBs window, click File — Print.

24 Event search in the Recognizers DBs

File | View  Settings  Servers  Internal SVDEs
Print Frch by alarms
Export.. a
Exit AND - r‘

2. Asaresult will launch report preview program.

4 Plates' protocol - Preview report [ & | 23]
File  View MNavigate Document Help
SHExE&s ([P aa® EEewme - 1QFE] 4 3
-~
1
Plates' protocol -
11 March 2021
Rssognizer Murmibar Country DirsoBan  Recognton Bme  Lisencs Flsisc apead Cafsgory  Lbsance plsds Image Synehronous samers
DE
LFR channsd 4 E1523MC1E3S 95z To camemn %f‘-;“ _
LFR channal 4 EIZIVYCIES 152 Ta camare ﬁzﬁ;‘:“
LFR channal 4 SOS4FMT a7 To camen ﬁf’éﬁ -
FRcnees 1 S034CEE = Tocames iy
LFR channel 1 BCO1TER TEz To camesz ﬁfa’;“
4 }
Pagelofd » Zoom104%
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If the Escort vehicles report type was selected:

4 Escort vehicles (KG73YK163) - Preview report [ &[]
File  View Navigate Document Help
A EHs L (PDaaaE EOGux -QAEITTEEIO
Escort vehicles (K673YK163)
11-Mar-21 12:58:20 PM
Frame License plate Mumber Count A
M7E3KO163 3
Y500YHG3 2
4 b
Pagel ofl ~ Zoom104%

Perform the necessary operations with a report in the report viewing window. All operations in this window are similar to those
described on the page Printing and exporting the vehicle data.

If there are more than 1000 entries in the search results the following message will be displayed before the preview report

program launch.
Print E3

&% MNumber of print jobs - 1436.
It is recommended to change search criteria
(e.g., shorten the data receive period or enable extra filters),

otherwise, printing can take long time or lead to lack of resources,
Continue printing?

Yes | ’ MNo

(@ Note

If the search results contain more than 1000 entries, the report may not be generated, because Windows does not
allocate more than 2 GB of memory to the x86-bit processes.
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Click Yes to continue. Click No to come back to change the search criteria.

3.3.12.4.2 Exporting the search results to JPG files
The events search results can be exported to JPG files. For each event, the following objects will be created:

+ a JPG file containing the frame from the main camera;

+ a JPG file containing the frame from the synchronous camera with the *_secondary.jpg name (if the synchronous camera
is configured);

« an archive containing meta data in the ARENA module format (if Debug4 mode is enabled). This functionality is required
for integration with the TRIS.

To export the events search results to JPG files, do the following:

1. Inthe main menu of the Event search in the Recognizers DBs window, click File — Export (1).
Event search in the Recognizers DBs

File | View  Settings Servers  Internal SWVDBs
Print yy alamms
Export... 1
Export to C5V
Exit

2. Inthe opened window select the folder in which the JPG files with search results are to be exported. Click OK.
Browse For Folder >
B This PC "

',E" kirill.kornoukhov (k-kornoukhov)
w = Local Disk ()
Export_files
Prograrn Files
Program Files (x26)
Users
Windows
a DVD Drive (Dv)

Clhmemed Cololmes (0% s crmmanames bnmedh T

Make Mew Folder Cancel

3. Asaresult all JPG files corresponding to event search results will be exported to the specified folder. File names contain
the following information:
detection tool ID, detection tool name, date and time, license plate, country (if defined), photo type (for example,
secondary indicates that a photo is taken from a second synchronous camera, if there is any).
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7 Quick access
B Desktop
* Downloads
Documents
[&=] Pictures

% % % % %

Export_files
J‘& Music
B videos
E This PiC
= Local Disk (C2)

« Local.. » Export_files w | 0

Search Export_files

[E] 1_LPRchannel1_2022-01-17_11-06-24-013_AR14EPOT_RUS
[=]1_LPRchannel1_2022-01-17_11-06-24-013_A614EP07_RUS_secondary
[&=]1_LPRchannel1_2022-01-17_11-08-33-307_A614EPOT_RUS
[=]1_LPRchannel1_2022-01-17_11-08-533-5307_AG14EP07_RUS_secondary
[=]1_LPRchannel1_2022-01-17_11-07-25-353_A614EPO7_RUS
[&] 1_LPRchannell_2022-01-17_11-07-25-353_A614EPO7_RUS_secondary
[&=]1_LPRchannel1_2022-01-17_11-07-57-607_A614EPOT_RUS
[&]1_LPRchannel1_2022-01-17_11-07-37-607_A614EP07_RUS_secondary
[E] 1_LPRchannel1_2022-01-17_11-08-29-330_AR14EPO7_RUS
[=]1_LPRchannel1_2022-01-17_11-08-29-530_A614EP07_RUS_secondary
[&=]1_LPRchannel1_2022-01-17_11-09-01-333_A614EPOT_RUS
[=]1_LPRchannel1_2022-01-17_11-09-01-333_A&14EP07_RUS_secondary

Exporting the events search results to JPG files is complete.

3.3.12.5 Previewing and printing the event data
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To view the event data, double left-click the corresponding string in the search results table. View event dialog window will open

in result.

View event

Prirt i

5
A470KP0O7 s TrIRw
Recognizer LPR channel 1
Country Russia
Recognition time 2022-01-19 18:14:22
Speed 7 km/h
Validity 98.% Comments:
Direction From camera
Camera Camera 1
6
4

In the View event window, the following event characteristics are displayed:

1. The main video frame with a caption which contains the following data (1):
a. Date and time of receiving the vehicle data;
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Vehicle speed;
Vehicle direction;
Speed, permitted on the controlled road area;
ID of speed detector;
Control site;
Name of the camera that captured the vehicle.
2. Addltlonal video frame if any (2).
3. Field (3) with the following data:
a. ldentified LP number;
b. Image of recognized LP.
4. Field (4) with the following data:
LP recognizer name;
Country;
Date and time of identifying the LP;
Vehicle speed;
Validity in %;
Vehicle direction in relation to the LP recognition camera;
Name of the camera that captured the vehicle.
5. Vehlcle data from the external LP database if the identified LP has been found there (5);
6. Comments to the event (6).

@ -0 20 T

‘@ D Qn T

To print the Report or/and export it to one of the most commonly used formats click the Print button (7). Preview report program
will launch in result. In the window of this program there will be displayed the Vehicle characteristics report.
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o Intellect

Vehicle data
Recognizer LPE. channel 1
Country Eussiz
Fecognition tme 2022-01-20 092724
Speed Jlmh
Speed lmit 601mh
Valdity 10%
Direction From cametz
Regional code 07
Camera Camera 1

PR channel 1

2022-01-2009:27:24

A614EP07
(7 km/h)

Perform the necessary operations with a report and then quit the program Preview report by following the points of the main
menu File -> Exit or by clicking the button ]| (see step 4 in Printing and exporting the vehicle data).

Using the Auto-Intellect software system - 66



Operator's Guide

3.3.12.6 Creating the Active tracking database

The Active tracking database is the Auto-Intellect database and is filled up by operator via the Vehicle Tracer module.

(@) Note.

« Itisimpossible to remove and change records via the Vehicle Tracer module except for changing the suspect

vehicle profile status.
+ All operator actions with the Active tracking database (for example, adding or deleting a suspect vehicle profile,
changing the start or end date of the suspect vehicle profile) are logged.

For total interaction between the Active tracking database and the Vehicle Tracing module the following conditions should be
met:

1. The Active tracking database should be connected to Auto-Intellect as an external plates database.
2. This external database should be used by the Vehicle Tracer module for analyzing the recognized license plates.

If the following conditions are met, the interaction between the Active tracking database and the Vehicle Tracer module is
performed in the following way:

1. The operator adds the vehicle LP to the Active tracking database via the Vehicle Tracer module, and specifies the reason

of its adding.
2. The Vehicle Tracer module compares the passing vehicle LP with the LPs stored in the Active tracking database. If the
correspondence between these LPs is established, the alarm event is generated with the location of the number in the

corresponding database.

The Active tracking option is convenient to be used in the Auto-Intellect distributed system, as it enables the operator at his
workstation to notify the remote workstation operators about the vehicle that is to be captured.

The information about the vehicle is added to the Active tracking database as follows:

1. Click the External Plates DB in the main menu of the Event search in the Recognizers DBs window.

ﬂ Event search in the Recognizers DBs

File  View  Settings Servers | Internal SVDEs

S _
i_Sean:h by vehicles | Search by alams I I External Plates DB 1 I I
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2. Asaresult the Internal SVDBs dialog window will open.

Internal SVDB - 'External Plates DB 1’ o || =[5

New report of vehicle found in DB | Al reports of vehicles found in DB |

T

3. Click Enter to add records to the database.

4. Indicate the start and expiration date of the suspect vehicle profile (1). All alarm events about the number being in the
corresponding external LP database will be guaranteed to be stored until the expiration of the suspect vehicle profile,
despite the periodic procedure for clearing the archive of events (see Configuring the database records retention period).

Cvternal Plates DB

terr = O x
Mew report of vehicle found in DB All reports of vehicles found in DB
Start date: |17/05/2021 14:58:06 [E | 1
Expiration date: |24/05/202114:58:06  [@~ |
License plate number: | | 2
3 Check the fact of driving |60 21 | mintes w  befaore the report is saved, on all servers 4
Operator: |User'| | 5
IIser rights: User permissions 1
Addttional info
Cancel Save 8

5. Inthe License plate number field (2) specify the vehicle number. To enter a two-line number, use two underscore
characters"__" as a line separator, for example: 123ABC__TH777.
6. Ifitis necessary to check the fact of vehicle driving to the vehicle report by all boundaries, do the following:
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« Set the Check the fact of driving checkbox (3).
« Enter the time period for which it is required to check the fact of vehicle driving to the vehicle report by all
boundaries (4).
7. The Operator field (5) indicates the current operator creating the suspect vehicle profile.
8. Inthe User rights list (6), set the check boxes for those Intellect user rights that should receive an alarm event when the LP
number is found in the database. In order for only the current operator to receive an alarm event, it is necessary to
uncheck all the boxes in the User rights list.

() Note

To receive alarm events, it is necessary that the selected user has full access to the External plates DB object, to
which the suspect vehicle profile is entered. If any restrictions are set in the user rights for the External plates
DB object, then users with such rights will not receive alarm events.

9. If necessary, in the Additional information field (7) enter a description of the reason for creating the
suspect vehicle profile.
10. Click Save to save changes (8).
() Note.

The suspect vehicle profiles added to the database receive the Active status.

11. Goto the All reports of vehicles found in DB tab to change the status of suspect vehicle profile.

Internal SVDE - 'External Plates DB 1’ [ |- =] (23]

Find: 4 Search 2 Edit Delete $

Mumber Date and Time End time Comment Active Operator User rights
-7 : 94 .4 I 5 User pemmissions 1
3 11.03.2021 14: 34: 32 |18.03.2021 14: 34: 32 3 [+ Smith User permissions 2

T[ Refresh H Change ]8 GT

12. Thetable displays a list of all suspect vehicle profiles in the database that the current operator has access to (1):
+ Inthe Number column, the LPs on the wanted list are displayed.
+ Inthe Date and Time column, the time of adding the vehicle report to the database is displayed.
« Inthe End time column, the expiration time of the suspect vehicle profile is displayed.
+ In the Comment column, the reason by which the vehicle report is created is displayed.
« Inthe Active column, the checkboxes are set for the active vehicle reports.
+ In the Operator column, the operator who added the vehicle report to the database is displayed.
+ Inthe User rights column, the rights of users who will receive an alarm event about finding a number in the
database is displayed.
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(@ Note

You can sort the suspect vehicle profiles by clicking on the name of the corresponding column.

The Date and Time, End time and Comment columns can be edited. To do this, select the corresponding value in the
column, then double-click on this value or click on the Edit button (2).

(@ Note

The columns Number, Operator and User rights are not editable.

To change the suspect vehicle profile status, in the Active column (3), set the check boxes for the suspect

vehicle profiles that are active, or uncheck the boxes for those suspect vehicle profiles that are inactive.

To search for the vehicle in the table, enter the search request in the Find field (4) and click the Search button. A list of
vehicles matching the search request will be displayed.

(@ Note

The data is searched in the following fields: Number, Date and Time, Operator, Comment.

To remove the selected suspect vehicle profile, click Delete (5).

To save the changes, click Save (6).

To update the list of suspect vehicle profiles, click Refresh (7).

To save all suspect vehicle profiles to a CSV file, click Change (8) and select the Save to CSV item.

To load previously saved suspect vehicle profiles from a CSV file, click Change (8) and select the Import from CSV item.

Adding the vehicle data to the External Plates DB is completed.

3.3.12.7 Viewing the video archive by event

Viewing the video archive by event can be initiated in three ways:

1.

2.
3.

Right-click the required event, and in the contextual menu select the Video archive option.

Mare Chrl+D

Wideo archive kel

Find

Left-click the required event, and on the keyboard push the Ctrl + M keys combination.
Holding the Shift key, double left-click the required event.

As a result, the video archive with videos of the event will open.
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Video archive

éi. Q 00 M 02 0% 04 05 06 O7 03 09 10 11 13 15 14 15 16 17 15 19 =20 21 a2z 23 a4
104342 [«]
105002
105022
105049
105116
10:51:36
10:51:56
10:52:16
105236
10:53:07
11:10:59
11:11:12
11:11:41
11:12:01
11112116
11:12:351
11:12:41
13:01

<« ppuEl»

To close the video archive, click the |£| button in the right upper corner of the window.

Viewing the video archive by event is completed.
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4 Description of the Auto-Intellect user interface

4.1 The Traffic Monitor interface object

4.1.1 Table panel of the Current value tab

The following figures show the Table sub-tab of the Current value tab displayed by lane and by direction respectively
(depending on the system setup).

Dispalying by lanes:

Displaying by direction:
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The following table describes the elements of the Table panel.

Field name Description

Time of registration The time when the last vehicle passed

Total number of vehicles Total number of registered vehicles of all types
Passenger cars The number of registered passenger cars

Trucks less than 11 m long The number of registered trucks less than 11 m long
Trucks from 11 to 14 m long The number of registered trucks from 11 to 14 m long
Trucks more than 14 m long The number of registered trucks more than 14 m long
Buses The number of registered buses

Registered speed of the vehicle The speed of the last registered vehicle, km/h

Vehicle length Total length of the registered vehicle, m
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Average speed for all vehicles

Average speed for passenger cars

Average speed for trucks

Distance between vehicles

Road load

Number of speed overruns

Moving along the oncoming lane

Number of vehicle stops

Jam

Number of incidents

4.1.2 Charts panel of the Current value tab

Operator's Guide

Description

Average speed for all registered vehicles, km/h

Average speed for passenger car vehicles, km/h

Average speed for registered trucks, km/h

The distance between the last vehicle and the previous one, m

Average road load, %

The number of speeding violations

The number of moving along the oncoming lane events

The number of vehicles stopped in the lane

Traffic jam indicator

Total number of road rules violations for the lane (direction)

The following figured show the Charts panel of the Current value tab displayed by lane and by direction, respectively

(depending on the system setup).

Displaying by lanes:
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The following table describes the elements of the Charts panel.

Number

of element

Description

The Traffic Detection object name

The lane number or direction

Total number of vehicles registered for the lane (direction)

Indication of a traffic jam in the lane (direction)

Chart showing the number of vehicles in the lane (direction)

Chart showing the road load of the lane (direction), %

Chart showing the statistics for the average speed of different vehicles types

4.1.3 Table panel of the Statistics tab

The following figure shows the Table sub-tab of the Statistics tab.
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The following table describes the elements of the Table sub-tab.

Number Description

of element

2 Set of elements for selecting the statistic frequency

3 Set of elements for entering the beginning and end dates and times of the traffic statistics period
4 The Refresh button refreshes the displayed statistics.

5 The Save as button exports the displayed statistics to a file

6 Traffic statistics results

4.1.4 Charts panel of the Statistics tab

The following figure shows the Charts panel of the Statistics tab.
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The following table describes the elements of the Charts panel.

Number Description

of elements

1 Set of elements for entering the beginning and end dates and times of the traffic statistics period
2 The Refresh button refreshes the displayed statistics.

3 The Save as button exports the displayed statistics to a file

4 Set of elements for selecting the statistic frequency
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Number

of elements

Description

The Traffic Detection object name

The lane number

Incident statistics for the lane

The road load chart

Chart showing the number of vehicles in the lane

4.2 The Vehicle Tracer interface description

4.2.1 The Events monitor

The Events monitor contains the following interface elements.

LPR channel 1

The Events monitor interface description is presented in the table:

Element number

Description

The passing vehicle LP detector

The frame with a passing vehicle and a caption
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Element number Description
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3 The identified LP number and the LP image

4.2.2 The Alarm window

The Alarm window contains the following interface elements.

1 Report of vehicle found in DB E Cﬁ.larms in total ZD
2 2018-08-29 17:50:37
2 Gcense S K673YK163 )
ecognition server LPR channel 1
4 Direction To camera
emal Vehicles DB Extemal Plates DB 1
5 State: Mot confimed
Field Value N
a2c98chf-%9abe811-aa18-1c1b0da b 3d5
License plate number KE73¥K163
Storage time ri
Active for search Yes
Date/time of creation 29.08.2018 17.42:.08
Wb i
fQEE:rator _J
ﬂ AP A
[=] 9 LY 1 1
(<< < > b Follow Approve (infarmation sent) Disapprove

The Alarm window interface description is presented in the following table.

Number Description

of

elemen

t

1 The signed video frame with moving vehicle

2 Date and time when the alarm event was recorded
3 Vehicle license plate number

4 Data about the tools that recorded the event

Note. The field with the name of the external database is hidden if the the alarm event was triggered manually.
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Number Description

of

elemen

t

5 Current state of the alarm event

There can be the following states of the alarm event:

« Not confirmed - a new event that has not yet been confirmed.

« Processing... - an alarm event is confirmed, but the information has not yet been recorded to the database.

« Confirmed - the alarm is confirmed and recorded to the database (you may not notice this state since the
event is deleted from the Alarm window after a successful confirmation).

« Error - the confirmation is not recorded to the database due to the heavy load on the Server. It is necessary to
confirm the event again.

6 Number of unprocessed alarm events

7 Description from the stolen vehicles database

Note. The table with the description from the stolen vehicles database is hidden if the the alarm event was triggered manually.
8 Go to the first alarm event in the list; go to the previous alarm event; go to the next alarm event; go to the last alarm event in the list

9 If the checkbox is set it disappears from all alarm windows in distributed environment when the alarm is confirmed, when the alarm is not
confirmed - only from the current alarm window.
If the checkbox is not set the alarm disappeared only from the current alarm window both when the alarm confirmed or not.

10 Confirm the event alarm status. The alarm is marked as received when click this button. The dialog box with the offer to print the alarm event
card will display.

11 Close the alarm window. The alarm status is not changed when click this button (alarm is not processed). Alarm will disappear from the Alarm
window.

4.2.3 The On-line monitor

The On-line monitor component contains the following interface elements.
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Server status

ONLINE MONITOR

Database:

M942BY163

Par

| Value

Recognizer

|LPR channel 1

Coui

ntry

|Russia

Recognition time

|2020707713 12:57:42

Validity

|80 %

Direction

|Tu camera

Reg

ional code

|163

Camera

|Camera 1

[ A232CX163

LPR channel 1
2020-07-13 12:57:43

M942BY163 Comment:

LPR channel 1
2020-07-13 12:57:42

[ Co11111

LPR channel 1
2020-07-13 12:57:39

[ BC01763

LPR channel 1
2020-07-13 12:57:39

The On-line monitor interface description is presented in the following table.

Element number

10

11

Description

Data about the last passed vehicle or event, selected in the identified vehicles protocol or in the
alarms protocol

Go to the Events tab of the identified vehicles protocol.

In case of the alarm event, go to the Alarms protocol tab.
This tab displays the video frame and the LP of the most recent alarm.

Hide the processed events in the protocols.

Enable/disable the pre-configured filters.

Resume the online update of the displayed vehicle protocol.

Alarm triggering by the operator.

Alarm acceptance.

Go to the list of errors occured in the Vehicle Tracer module.

Displaying the information from the external database.

Data about the identified objects protocol or the alarms protocol (depends on the activated tabs -
Events tab or Alarms protocol tab).
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Element number

12

13

14

15

16

17

18
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Description

Hide/show the panel with comments and external database.

Comments to the selected event.

Create the report with data about the selected event.

Open the window for search in the plates recognizers databases.

Go to the video archive of identified vehicles.

Go to the filter settings, used in protocols.

Comments to the selected event with specified date and time of the comment creation.

4.2.4 The Events search in recognizers databases

The Events search in the recognizers DBs dialog window contains the following interface elements.

2 Event search in the Recognizers DBs

C-File View  Settings  Servers Int&rnalS'ﬁ'DB:)'I

@earch by vehicles | Search by EI|EITI'IED2

>

Vehicle's license plate:

-

=N R ==

License plate not recognized
[] Partly recognized

m

[ <ot specified=

Regional code:

Search operation: AND - (6

License plate Frame MNumber Flate region

Plate region: ngg(_'_‘c_-"lq F7 | 4

Regional

code

m

[ <not specified=

P8I1EA|7T]

LP colars: ]
[T] not specified= A 588 CP - A53BCP50
B4LTERTT B47EP 150
k Date/ Time j '\"_I

Reset Find C
=
)

v,
from h3 |
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The Events search in the recognizers DBs interface description is presented in the following table.

Element number Description

1 The main menu that enables to do the following operations:

1. File command:

a. Printing the events search results;

b. Closing the Events search in the recognizers DBs window.
2. View command:

a. Configuring the display of remote servers and databases;
3. Settings command:

a. Configuring the display of events search results;

b. Connecting the recognizers databases.
4. Servers command:

a. Selecting the databases for searching the events.
5. Internal SVDBs command:

a. Editing the user Active tracking database.

2 Selecting the serch type: by vehicles or by alarms.

3 Forming the search query of the selected search type.
4 Clearing the search form from the given search criteria.
5 Launching the search query processing.

6 Events search results table.

7 Navigation panel of the events search results.

4.2.5 The preview report

The preview report program window contains the following interface elements.
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" 2 Vehicle data - Preview report =)
File  View Mavigate Document Help ]1
S aEB#Rs a0 &NC D G1s% -0 t 14 8]0 .
r QXXON -\
&3 Intellect
Vehicle data
Recognizer LPR channel 1
Country Russia
Recognition time 2020-07-13 12:37:45
Speed 47 km/h L
Speed limit 40 kin/h
Speeding 7 km/h
Validity 83 %
Direction To camera
Regional code 163
Camera Camera 1 9
LPR channel 1
2020-07-13 12:37:45
K673YK163
(47 km/h)
\_ v,
Pagelofl - Zooml123%

The preview report interface description is presented in the following table.

Element number

Description

1 Main menu for viewing the reports (operations with a file, operations of previewing and navigating the
report, operation with a report, viewing the information about program).

2 Group of elements for operations with a report file (printing, opening, saving, exporting).

3 Group of elements for operations with a report (displaying, content, search, update, edit).

4 Selecting the scaling mode and the scale of displaying the report.
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Element number Description

5 Zooming the report.

6 Selecting the mode of displaying the report (page-by-page, nonstop page-by-page).
7 Group of elements for navigation in the report.

8 Undo or redo the last action.

9 Field for displaying the formed report.
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